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Реферат. Определение средних значений количества, периметра и площади CD34-положительных 
сосудов и оценка экспрессии VEGF в биоптатах кожи пациентов с сосудистыми формами розацеа. 
Старостина О.А. Розацеа характеризуется поражением центральной части лица с формированием 
транзиторной или персистирующей эритемы, телеангиэктазий, папул, пустул и гиперплазией соединительной 
ткани. Формирование телеангиэктазий поверхностных и промежуточных участков дермы является важной 
цепью патогенеза сосудистых форм розацеа. Современные источники литературы позволяют отнести это 
заболевание к группе ангиопролиферативных заболеваний, которые основаны на активации воспаления и 
ангиогенеза. Это приводит к необходимости изучения механизмов ангиогенеза, обусловленных факторами 
роста сосудистых компонентов или их рецепторами при розацеа. Целью исследования было рассчитать 
средние значения периметров и площадей CD34-положительных сосудов, оценить интенсивность экспрессии 
маркера VEGF в биоптатах кожи с сосудистыми формами розацеа и определить возможную зависимость 
этих показателей от возраста пациентов. В работе был проведен иммуногистохимический анализ материала 
11 пациенток в возрасте от 21 до 63 лет (среднее 40,0±12,49, медиана 36 лет) с клиническим диагнозом 
сосудистая форма розацеа. Разветвления, дилатация и уплотнение капиллярной сети были типичными из-
менениями дермы при сосудистых формах розацеа, которые наблюдались на всем протяжении среза, с 
усилением в направлении «сверху вниз», особенно вокруг сальных желез и волосяных фолликулов. Установлено, 
что средние значения количества, периметров и площадей CD34-положительных сосудов в биоптатах с 
розацеа, а также уровни интенсивности экспрессии VEGF значительно превышали таковые показатели 
здоровой кожи (все р<0,05). 
 
Abstract. Determination of mean values of the number, perimeter and area of CD34-positive of rosacea vessels 
and evaluation of VEGF expression in skin biopsy specimens of patients with vascular forms. Starostina О.А. 
Rosacea is characterized by marked involvement of the central face with transient or persistent erythema formation, 
telangiectasias, inflammatory papules and pustules and hyperplasia of the connective tissue. The formation of 
telangiectasia of the surface and intermediate sections of the dermis is an important chain of pathogenesis of vascular 
forms of rosacea. Modern literature sources allow to attribute this disease to the group of angioproliferative diseases, 
which are based on the activation of the inflammation and angiogenesis. This leads to the need of studing the 
mechanisms of vascularization due to growth factors of the vascular components or their receptors in rosacea. The aim 
of the study was to calculate the mean values of the perimeters and areas of CD34-positive vessels, to evaluate the 
intensity of expression of the VEGF marker in the skin biopsies of patients with vascular forms of rosacea and to 
determine the possible dependence of these parameters on the age of the patients. In the work, an immunohistochemical 
analysis of the material of 11 patients aged 21 to 63 years (mean 40,0±12,49, median 36 years) with a clinical 
diagnosis of the vascular form of rosacea was performed. Branching, dilatation and induration of the capillary mesh 
were the typical changes in the dermis in vascular forms of rosacea. which were observed throughout the length of the 
incisions with an increase in the direction "from the top down", especially around the sebaceous glands and hair 
follicles. It was established that the mean values of the number, perimeters, and areas of CD34-positive vessels in 
rosacea biopsy specimens, as well as the levels of VEGF expression, were significantly higher than those of healthy skin 
(all p<0,05). 

 
Предметом сучасних наукових досліджень 

при розацеа є взаємодія всіх ланок підтримання 
гомеостазу організму. На цей момент здебіль-
шого вивчається гуморальна та імунна регуляція 
при розацеа, а саме: вазомоторні зміни та зміни 
локального гомеостазу гастроінтестинального 
тракту, а також місцева відповідь на заселення 
кліща Demodex [4, 9, 11, 12]. Морфологія пато-
логічних змін судинного компонента дерми при 
розацеа набуває особливо важливого значення 
під час вибору тактики лікування пацієнтів [10].  

За Cribier B. (2011, 2013), важливою ланкою 
патогенезу при судинній розацеа стає формуван-
ня телеангіоектазій поверхневих та проміжних 
ділянок дерми [4, 5], що наводить на думку про 
необхідність дослідження механізмів судиноут-
ворення через фактори росту компонентів судин 
або їх рецептори. Тому використання імуно-
гістохімічного методу (ІГХ) для дослідження стану 
васкуляризації шкіри при судинних формах 
розацеа доцільно з маркерами ендотеліального 

диференціювання CD34 та фактора росту ендо-
телію судин VEGF, що часто зустрічаються в 
роботах провідних спеціалістів патоморфологів 
та дерматологів при оцінюванні судинного 
компонента неопластичних та запальних за-
хворювань шкіри [6, 7, 8]. 

Мета дослідження – оцінити середні значення 
кількості, периметрів і площ CD34-позитивних 
судин та інтенсивність експресії маркера VEGF у 
біоптатах шкіри обличчя пацієнток з судинною 
розацеа, порівняно з даними здорової шкіри, та 
виявити можливу залежність отриманих по-
казників від віку пацієнток. 

МАТЕРІАЛИ ТА МЕТОДИ ДОСЛІДЖЕНЬ 

У роботі проведено ретроспективний аналіз 
матеріалу шкіри обличчя 11 пацієнток віком від 
21 до 63 років (середнє 40±12,49, медіана 36 ро-
ків) з клінічним діагнозом судинна форма 
розацеа (СФР), отриманого протягом січня 2014 - 
жовтня 2015 року на базі медичного центру ПП 
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«Леномед», м. Дніпро. Для контрольної групи 
умовно «здорової шкіри» були використані мате-
ріали шкіри пацієнтів без патологічних змін, па-
цієнтів віком від 18 до 54 років (середнє 36±9,53, 
медіана 37 років). Діагноз еритематозно-телеан-
гіектатична (судинна) форма розацеа був під-
тверджений гістологічно на базі Дніпропет-
ровського обласного патологоанатомічного бю-
ро, де світлова мікроскопія проводилась з вико-
ристанням мікроскопа «Leika DLM-E» (США), 

об’єктивами ×20, ×40, ×100. Імуногістохімічне 
дослідження (ІГХ) проводилось згідно з прото-
колами компанії TermoScientific (TS), (США). У 
зрізах завтовшки 4 мкм використовували сис-
тему візуалізації Lab Vision Quanto (TS, США) з 
виявленням білкового ланцюга за допомогою 
DAB Quanto Chromogen (TS, США). В якості 
первинних використовувалися моноклональні 
антитіла до VEGF, CD34. Титр, клон, виробник 
антитіл наведені в таблиці 1. 

 

Т а б л и ц я  1   

Панель первинних антитіл 

Антитіло Клон Розведення Виробник 

VEGF 
CD34 

клон VG1 
клон QBEnd 10 

1:100 
1:100 

LabVision 
LabVision 

 

Для стандартизації результатів визначення 
середньої кількості судин, їх периметру та площі 
проводилось у трьох полях зору (гарячих точках) 
тільки верхніх шарів дерми (безпосередньо під 
епідермісом) кожного окремого випадку при 
збільшенні (х400). Кількісне оцінювання судин-
ного компонента строми біоптатів проводилося в 
програмі обробки цифрових зображень ImageJ: 
Analyze > Tools > ROI Manager за методикою, 
описаною в роботі [2]. Інтенсивність цито-
плазматичного зафарбовування маркером VEGF 
в епідермісі та епітелії волосяних фоліку-
лів/епітелії залоз біоптатів СФР розраховувалась 
у балах яскравості коричневого кольору хромо-
гена DAB програмою обробки цифрових зо-
бражень ImageJ: Plugins > Colour functions > 
Colour Deconvolution + Analyze > Histogram, де 
біле – це 255 балів (максимальне значення), а 0 – 
чорне, тобто чим інтенсивність VEGF була силь-
нішою, тим кількість балів яскравості була мен-
шою [3]. Показники кількості, периметрів та 
площ CD34-позитивних судин, а також показ-
ники рівнів інтенсивності експресії VEGF під-
лягали статистичному опрацюванню в програмах 
ImageJ і Microsoft Excel із розрахунком міні-
мального, максимального, медіани, середнього 
арифметичного та стандартного відхилення. До-
стовірна різниця між групами перевірялась за t-
критерієм, на рівні р<0,05 [1].  

РЕЗУЛЬТАТИ ТА ЇХ ОБГОВОРЕННЯ 
Якісний та кількісний аналіз процесів васку-

ляризації потребує чіткої візуалізації судинних 
елементів серед інших стромальних компонентів 
дерми. Завдяки маркеру ендотеліальної дифе-
ренціації CD34 у біоптатах СФР ми відокремили 
судини різних шарів дерми і зафіксували значне 

збільшення кількості судин у напрямку «зверху 
вниз», тобто від епідермісу до глибоких шарів 
дерми. Розгалуження, дилатація та ущільнення 
капілярної сітки були типовими змінами і 
спостерігалися по всій довжині зрізу, особливо 
навколо сальних залоз та волосяних фолікулів 
(рис. 1). Порівняно зі здоровою шкірою, у зраз-
ках СФР можна відзначити значне збільшення 
площі перерізу отвору судин та периметра ка-
пілярної сітки проміжних і глибоких відділів 
дерми. Точний вимір середнього периметра су-
динної сітки вірогідно продемонструє нам зміну 
діаметра судинних елементів порівняно зі здо-
ровою шкірою, а розрахунок площі перерізу 
отвору судин – свідчить про ступінь дилатації 
патологічно змінених судин (розширення, повно-
крів’я або навпаки).  

Кількість судинних елементів верхніх шарів 
дерми в 3 «гарячих точках» всіх зразків СФР ко-
ливалася від 21 до 41 (медіана 31), середнє зна-
чення становить 31,454±6,470 (табл. 2). Для по-
рівняння, у здоровій шкірі ці параметри були 
значно нижчими – від 7 до 12 (медіана 8), 
середнє 7,631±1,265 (р<0,05).  

Середні площі перерізу судин досліджених ви-
падків СФР коливались від 206,134±31,299 мкм2 до 
1159,916±458,791 мкм2, і в середньому стано-
вили 549,621±277,179 мкм2 що значно пере-
вищило показники здорової шкіри (від 
32,012±5,634 мкм2 до 141,007±24,901 мкм2, се-
реднє 68,621±18,812 мкм2), (p<0,05). Збільшен-
ня середньої площі перерізу отвору судин 
свідчить про значну дилатацію (повнокрів’я, роз-
тягнення) судинного русла дерми при СФР 
порівняно зі здоровою шкірою, поетапну втрату 
тонусу стінок через ушкодження ендотелію. 
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Рис. 1. Мембранна реакція ендотелію судин  

з маркером CD34, ІГХ з гематоксиліном Майєра, 
(х400) 

Середній периметр судинного русла СФР 
ко_ливався в межах від 72,256±9,432 мкм до 
130,635±24,824 мкм, що в середньому становило 
100,320±19,344 мкм. Такі дані свідчать про 
збільшення довжини судинного русла (навіть 
якщо зріз проходить не вздовж, а тангенціально 
або поперек), збільшення кількості кіл вимірю-
ваних об’єктів показує сильне розгалуження 
судин та активність процесів васкулогенезу при 
СФР, на відміну від здорової шкіри зі значно 
біднішими показниками периметрів «гарячих 
точок» з 25,201±6,005 мкм до 42,980±9,118 мкм, 
середнє – 36,775±7,864 мкм (p<0,05). 

Графічні відображення залежності розподілу 
середніх площ та периметрів зразків СФР від 
віку пацієнтів представлено на рисунку 2 від-
повідно. Маємо тенденцію до деякого підви-
щення показників васкуляризації в проміжок між 
34 та 60 роками, що співпадає з результатами 
досліджень інших авторів [8, 9]. 

 

Т а б л и ц я  2   

Показники кількості, площі та периметра CD34+ судинного компонента  
верхніх шарів дерми пацієнтів із СФР, n, mkm2, mkm 

Середня площа 
(mkm2) 

Середній периметр 
(mkm) № 

Вік 
(р.) 

Сумарна кількість 
(в 3 п/зор) 

CD34+ судин (n) x  Max
 

Min
 x  Max

 
Min

 

1 21 31 206,134 714,964 0,561 72,256 289,185 7,551 

2 33 38 361,016 2455,773 39,766 84,693 305,077 24,486 

3 33 26 332,682 1588,417 22,359 90,318 280,191 19,257 

4 34 40 669,276 8616,198 94,835 102,515 363,264 40,868 

5 34 32 597,006 5576,826 75,746 114,826 445,607 41,409 

6 36 29 282,946 1408,000 40,069 77,115 281,024 28,137 

7 38 25 861,017 4507,348 69,975 124,095 436,816 33,919 

8 39 41 581,098 3007,363 67,779 110,726 385,359 36,898 

9 49 21 1159,916 8252,758 65,560 130,635 422,541 39,680 

10 60 28 542,714 1634,807 77,265 109,458 285,955 37,809 

11 63 35 452,031 2718,163 42,920 86,889 224,734 25,669 

x   31,454 549,621   100,320   

xs   6,470 277,179   19,344   

Мax  41 1159,916   130,635   

Min  21 206,134   72,256   

Med  31 542,714   102,515   

П р и м і т к и :  x  – середня арифметична; 
xs  – середнє квадратичне відхилення; Max – максимальне; Min – мінімальне; Med – медіана. 
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Рис. 2. А. Розподіл середніх площ (мкм2) CD34+судин верхніх шарів дерми шкіри із СФР  
за віком пацієнтів (роки). Б. Розподіл середніх величин периметрів (мкм) CD34+судинного русла  

зразків СФР за віком пацієнтів (роки) 

 
Активація процесів васкулогенезу не можлива 

без участі фактора росту ендотелію судин VEGF, 
що експресується в цитоплазмі епітеліальних, 

ендотеліальних та стромальних клітин. Наявність 
експресії цього фактора чітко корелює зі щіль-
ністю судин, як показано на рисунку 3.  

мкм2 

мкм 
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Рис. 3. Цитоплазматична помірна експресія (++) 

маркера VEGF в епідермісі, ендотелії судин  
та поодиноких стромальних клітинах, ІГХ з 

гематоксиліном Майєра, (х400) 
 

У дослідженні оцінювалась інтенсивність 
забарвлення  маркером  VEGF  в  епідермісі  та  

епітелії волосяних фолікулів/епітелії залоз біоп-
татів СФР, яка зустрічалась у вигляді слабкої (+) 
та помірної (++) інтенсивності. Більшість ви-
падків демонстрували рівномірне зафарбовуван-
ня, але треба відзначити і кластерні (вогнищеві) 
реакції, що мали місце в акантотичних тяжах.  

Середні значення інтенсивності реакції 
епідермісу біоптатів із СФР коливалися від 
168,789±34,941 (найсвітліший зразок) до 
54,714±39,217 (найтемніший) і в середньому 
становили 113,396±32,397. Для фолікулярного 
епітелію та епітелію залоз цифри виявилися 
157,767±42,596 (найсвітліший зразок) до 
93,071±44,892 (найтемніший), у середньому – 
122,696±20,361 відповідно (табл. 3). Для порів-
няння, показники здорового епідермісу стано-
вили 184,254±28,694, а фолікулярного епітелію / 
епітелію залоз – 193,812±31,037, що відображає 
базовий рівень експресії VEGF (всі р<0,05). Роз-
поділ значень експресії VEGF за віком пацієнтів, 
представлений на рисунку 4, демонструє, що рів-
ні інтенсивності експресії VEGF епідермісу були 
трохи нижчими (тобто більш темними), ніж 
фолікулярного епітелію / епітелію залоз, неза-
лежно від віку пацієнтів, що може свідчити про 
первинне ураження епідермісу із подальшим 
розповсюдженням у підлеглі тканини. 

 

Т а б л и ц я  3   

Інтенсивність експресії фактора росту ендотелію VEGF у СФР  
у балах яскравості за гістограмою програми ImageJ 

Рівень експресії VEGF 
епідермісу шкіри (бали) 

Рівень експресії VEGF фолікулярного епітелію та 
епітелію залоз (бали) № 

Вік 
(р.) x  SD x  SD

 

1 21 102,664 41,236 148,721 45,45 

2 33 72,636 33,212 118,859 37,646 

3 33 152,013 36,919 129,826 41,231 

4 34 106,492 42,2 129,662 34,393 

5 34 168,789 34,941 157,767 42,596 

6 36 100,963 37,521 107,407 45,358 

7 38 113,122 40,25 117,77 34,541 

8 39 54,714 39,217 93,071 44,892 

9 49 118,822 30,159 102,664 45,363 

10 60 132,01 33,236 139,087 33,557 

11 63 125,137 34,326 104,832 32,513 

x   113,396  122,696  

xs   32,397  20,361  

Мax  113,122  118,859  

Min  168,789  157,767  

Med  54,714  93,071  

П р и м і т к и :  x  – середня арифметична; SD – cтандартна похибка середнього; Max – максимальне; Min – мінімальне; Med – медіана. 
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Рис. 4. А. Розподіл середніх балів яскравості експресії VEGF епідермісу шкіри при СФР за гістограмою 
програми ImaiJ (бали) відповідно до віку пацієнтів (роки). Б. Розподіл середніх балів яскравості  

експресії VEGF фолікулярного епітелію та епітелію залоз при СФР за гістограмою  
програми ImaiJ (бали) відповідно до віку пацієнтів (роки) 

 
ПІДСУМОК 
Розгалуження, дилатація та ущільнення капі-

лярної сітки були типовими  змінами  дерми  при  

 
судинній розацеа і спостерігалися по всій дов-
жині зрізів зі збільшенням у напрямку «зверху 
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вниз», особливо навколо сальних залоз та во-
лосяних фолікулів. Середні значення кількості, 
периметрів та площ CD34-позитивних судин у 
біоптатах із судиними формами розацеа, а також 
рівні інтенсивності експресії VEGF значно 
перевищували такі показники здорової шкіри (всі 
р<0,05). Рівні інтенсивності експресії VEGF епі-
дермісу виявилися нижчими, ніж фолікулярного 
епітелію/епітелію залоз, і не залежали від віку 
пацієнток. 

Перспективи подальших розробок. До-
слідження гормонального статусу пацієнтів із 
СФР стосовно рецепторів до естрогенів/андро-

генів (ER/AR) та активності прозапального фер-
менту COX-2 для вибору ефективної терапії є 
перспективним напрямком досліджень вищеза-
значеної патології шкіри. 

 
Дослідження виконано в рамках науково-

дослідної роботи кафедри шкірних та венерич-
них хвороб ДЗ «ДМА» «Порушення адаптаційних 
механізмів при дерматозах і інфекціях, що пе-
редаються статевим шляхом, і методи їх корек-
ції» (номер державної реєстрації 0100U000395, 
термін виконання 2015-2018). 
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Реферат. Клініко-патогенетичне обґрунтування використання вобензиму в комплексному лікуванні 
генералізованого пародонтиту. Мащенко І.С., Кучеренко Т.О. Метою цього дослідження служило ви-
значення ефективності використання в комплексному лікуванні генералізованого пародонтиту вобензиму в 
якості загальної терапії. Обстежено 61 хворий, з I-II ступенем тяжкості, зі збереженням зубів у кількості не 
менше 90%, без супутньої загальної патології, що вимагає лікування на поточний момент. Порівняльна ефек-
тивність лікування була вивчена в 2-х групах, аналогічних за всіма клінічними показниками. Пацієнти основної 
(31 особа) групи отримували, поряд із симптоматичним лікуванням, Вобензим; контрольної (30 осіб) - 
полімедикаментозну терапію (імунокорегуючі, антиоксидантні, протимікробні засоби). У результаті за-
гальноприйнятих клінічних, параклінічних, імунологічних, біохімічних досліджень, проведених у процесі ліку-
вання і у віддалені терміни спостереження, виявлено, що використання системної ензимотерапії у цієї 
категорії хворих забезпечує швидкий регрес основних клінічних симптомів (на 6-7 день), усунення пато-
генетичних ланок захворювання більше ніж у 90% пролікованих і настання ремісії протягом не менше 6-12 
місяців. Характерно, що при проведенні монотерапії вобензимом досягалися позитивні результати лікування 
генералізованого пародонтиту, аналогічні з такими, що і при використанні комплексної стандартної терапії, 
що включає призначення цілого ряду медикаментозних препаратів цілеспрямованої дії на механізми патогенезу 
захворювання. З позиції доказової медицини обґрунтовано доцільність заміни широкого арсеналу лікарських 
засобів у комплексному лікуванні генералізованого пародонтиту на окремі фармакологічні препарати, що 
чинять системну дію. 


